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About this manual 

Welcome to DOORSnet, a web-based front end to DOORS. 

Learn how to use DOORSnet by running the interactive tutorial. It only takes five minutes. On 
DOORSnet's Help tab, click Interactive tutorial. 

This book describes how to use version 7.0 of DOORSnet. 

Typographical The following typographical conventions are used in this manual: 
conventions 

Typeface or Meaning 
Symbol 

Bold	 Book titles, important items, and items that you can select, including 
buttons and menus. For example: Click Yes to continue. 

Courier	 Commands, files, and directories; computer output. For example: Edit 
your .properties file. 

>	 A menu choice. For example: Select File > Open. This means select the 
File menu, then select the Open command from it. 

Related The following table describes where to find information in the DOORSnet documentation set: 
documentation 

For information on See 

What's new in version 7.0 of DOORSnet The DOORSnet readme file 

How to install, configure, and set up licenses Installing and Setting up 
to use DOORSnet 

How to manage DOORSnet Managing DOORSnet 

You'll find PDF versions of these manuals on: 

• The DOORS Enterprise Requirements Suite documentation CD 

• Our  web  site at http://support.telelogic.com 
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1 Concepts 

This chapter introduces DOORSnet and explains the concepts you need to understand to use it: 

• What  is DOORSnet? 

• Modules 

• Objects and attributes 

• Links 

• Views 

• Folders and projects 

• Searching for data 

• Editable sections and locks 

• Suggestions and change proposals 

• Staple  sets 

• Table and book formats 

• Registered and anonymous users 

What is DOORSnet is a web-based front end to DOORS. It lets you use your web browser to access the 
DOORSnet? information stored in DOORS databases. 

DOORSnet has two different types of licenses: 

•	 Edit licenses 

If your site has edit licenses, you can edit the DOORS data using your web browser. 

• Browse licenses 

If your site only has browse licenses, you can look at the data, but you can't edit it. 

DOORSnet also provides a web-based front end to the DOORS Change Proposal System. If your 
DOORS administrator has configured the data for review, you can submit comments on it. You can 
look at your own and other people's comments, and monitor the progress of the comments as they 
progress through the review cycle. 

You only need a web browser—you don't need any special DOORSnet software on your computer. 
DOORSnet lets users throughout the world access live DOORS data using standard web 
browsers—Internet Explorer and Netscape. 

Modules The information in a DOORS database is stored in modules. 
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For example, a boat manufacturer is currently building a sailboat and a canoe. 

The information for the sailboat project is stored in several modules, as shown in the following 
example, including: 

•	 A user requirements module, which contains information about the features users want in the 
boat. 

• A design module, which describes the engineering design of the boat. 

• A safety tests module, which describes the safety tests that must be carried out on the boat. 

Objects and Within each module, the information is organized as a table. The rows are called objects and the 
attributes columns are called attributes. 
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The following example shows the system requirements module for the Sailboat project. 

Notice that the information is organized in a hierarchical structure using numbered headings. For 
example, underneath heading number 2.1 (Ready to Sail), there are subheadings numbered 2.1.1 
(Load Boat), 2.1.2 (Transport Boat), and so on. 

The heading numbers work in the same way as automatic heading numbers in a word processor such 
as Microsoft Word. They let you see the structure of the information in the module. And they 
automatically change if you change the structure of the information, for example, if you insert or 
delete objects. 

The Object Heading and Object Text attributes 
In , the big column on the left, Sailboat Requirements, is the main column. Unlike other columns, 
which only contain one attribute, the main column displays two attributes. 

Attributes in the Description 
main column 

Object Heading	 The words in this attribute are shown in bold, and DOORS automatically 
generates and displays a heading number. 
For example, look at the object at the bottom of : 
• The Object Heading attribute contains the words Unload Boat. 

•	 DOORS automatically generates the heading number, 2.1.3, which 
shows the object's position in the hierarchy. 
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(Continued) 

Attributes in the Description 
main column 

Object Text	 The words in this attribute are shown in the normal font. 
For example, look at the object just above the bottom of : 
•	 Its Object Text attribute contains the words The boat shall be 

transportable using a family car with a trailer. 

• Its Object Heading is blank; it isn't a heading, it's just normal text. 

Note:	 Normally each object is either a heading or normal text—either its Object Text is blank (it's 
a heading) or its Object Heading is blank (it's normal text). 

Links	 Related objects in the same or different projects can be linked together using DOORS, and you can 
follow the links by simply clicking on them. 

Links let you trace a requirement to the design features that fulfill the requirement, through to the 
tests that will be carried out to verify the design features. 

You can follow links in both directions. For example, if a test fails, you can find out which 
requirements are affected by tracing the links from the test back to the design features, back to the 
requirements. 

Views Different people need to see different information. For example: 

• Managers are interested in information about scheduling and costs. 

• Engineers are interested in technical design information. 
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So DOORS administrators create different views of modules for different groups of users. Each 
view contains a subset of the objects or attributes in the module. 

This illustration shows two views of the design module for our Sailboat project: 

•	 The Management view contains only the high priority items and only shows the priority and cost 
attributes. 

• The Engineering view contains all the items but only shows the design attribute. 

Views let you see exactly what you need without being overwhelmed by the sheer volume of 
information in the module. They filter out the data you don't want to see. They can filter out the 
objects you don't want to see, or the attributes you don't want to see, or both. 

Folders and DOORS administrators use folders to organize the modules in the DOORS database, in the same 
projects way that you use folders to organize the files on your computer. 

A project is just a special kind of folder that contains all the data for a particular project. For 
example, all the information for the boat manufacturer's sailboat project is in a project called 
Sailboat. 
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Within the Sailboat project, there is a folder for Archive items and a folder for Postponed items. 

You navigate the data using the DOORSnet Explorer, which looks and behaves like the Windows 
Explorer. 

For example, click the plus sign to the left of the Requirements module to see all the views available 
for that module. Click a view to open the module in that view. 

Note:	 You can distinguish formal and descriptive modules by the icon in the DOORSnet 
Explorer. Formal modules have a bow tie in the top right corner. 

Projects that are contained in other projects are shown in their true position in the database 
structure, and at the top level. 

For example, the Tiller project is contained within the Sailboat project, and appears both as a 
sub-project of Sailboat and at the top level of the database structure. 

Searching for You can search for objects in the current view that match a particular search criteria. 
data	 For example, you can do a simple search for objects that contain the word “Judy”. Or you can do a 

more advanced search for objects that have “High” in the Priority column and “Judy” in the Who 
column. 

You can use either: 

• The filter option to filter out all the objects that don't match your search criteria. 
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•	 The find option to leave all the objects visible on your screen, and highlight the ones that match 
your search criteria. 

Editable 
sections and 
locks 

Note: Ignore this section if your site doesn't have any DOORSnet edit licenses. 

DOORS users can divide modules into editable sections and give individual users access to some 
sections and not others. For example, people in an engineering team might be allowed to read, but 
not edit, information created by the marketing team. 

You can edit one section while someone else is editing another. When you edit, insert or delete 
objects, DOORSnet automatically locks the section the objects are in. 

You can tell which section you have locked because its action buttons are green with a white arrow 
instead of beige, and the text that you can edit is green, not black. Within your locked section, text 
that you aren’t allowed to edit is black. 

Only one person can edit a section at a time. So, when you've finished your edits, you should always 
unlock the section you've been working on so that other users can edit it. 

Note:	 If you edit a module that isn't split into editable sections, DOORSnet locks the entire 
module. 

Suggestions and If a module is configured for review, you can comment on the data in it. 
change You can make two types of comments. We use the term proposal for both types of comment. 
proposals 

Proposal Description 

Suggestion	 This is a high-level comment. 
For example, the suggestion that a project should have a test plan. 
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(Continued) 

Proposal Description 

Change proposal This is a detailed comment on a particular object in the database. 
For example, the proposal that the estimated duration of a particular task 
should be changed from 20 days to 30 days. 

A review team (sometimes called a Change Control Board, or CCB) looks at each comment and 
decides on the appropriate course of action. They decide whether to accept, reject, or defer each 
comment. 

DOORSnet can automatically e-mail you if the status of one of your proposals changes, for example, 
if one of your proposals is accepted. 

Staple sets	 Quite often two or more people make similar proposals. When this happens, the review team group 
together, or staple, the proposals. 

The group of similar proposals is called a staple set. One proposal in the set is the master, and the 
rest are slaves. 

When the review team meet, they treat the staple set like a single proposal. They either accept, reject 
or defer the master proposal. 

They use the master to record the status of the staple set and any comments they want to make on it. 
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Table and book You can control the format that DOORSnet uses to display information in your browser. 
formats By default, it uses a compact table format, which displays attributes in columns. 

If you prefer, you can select the book format, which displays each attribute for an object on a 
separate line. 

Registered and There are two types of DOORSnet users, registered users and anonymous users. Typically, 
anonymous anonymous users are infrequent DOORSnet users who don't need to use all of the features. 

users You can tell which type of user you are from the URL you're given to access DOORSnet: 

• If the URL ends in anon.html, you're an anonymous user. 
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• If the URL doesn't end in anon.html, you're a registered user. 

If you're a Then 

Registered user	 You have to register with DOORSnet before you can access the data stored 
in the DOORS database. You only need to do this once. 
To look at the DOORS database, you have to type in a username (and 
maybe also a password). 
The proposals you make can be traced back to you. The project's review 
team knows which registered user submitted which proposal. 
You can control various user preferences, such as whether you're notified 
by e-mail when the status of one of your proposals changes. 

Anonymous user You don't have to register with DOORSnet. 
You don't have to type in a username or password to access the DOORS 
database. 
The proposals you make can't be traced back to you. You're anonymous. 
You can't control as many user preferences as registered users. For 
example, you can't be notified by e-mail when the status of one of your 
proposals changes. 
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2 Getting started 

This section contains the following topic: 

• Accessing DOORSnet 

Accessing If the URL your DOORSnet administrator gave you to access DOORSnet ends in anon.html, 
DOORSnet you're an anonymous user. If not you're a registered user. 

Follow these steps to get started with DOORSnet: 

1.	 Bookmark your DOORSnet Access Page. 

The following table describes how to do this. 

If you are a registered user If you are an anonymous user 

Do this: 
a.	 Go to the URL your DOORSnet 

administrator gave you. 

You see the DOORSnet registration 
page. 

b.	 Type in your name and e-mail address, 
then click OK. 

You see the DOORSnet Access Page. 

c. Bookmark the page. 

Do this: 
a.	 Go to the URL your DOORSnet 

administrator gave you. 

DOORSnet generates a unique 
Access Page for you, which you 
should use to access DOORSnet 
in future. 

b. Bookmark the page. 

Note: In future sessions, use your bookmark to go straight to the DOORSnet Access Page. 

2. Run the interactive tutorial. 

Learn how to use DOORSnet by running the interactive tutorial. It only takes five minutes. On 
the DOORSnet Access Page, click Interactive tutorial on the Help tab. 

3.	 Log in to the database. 

On the DOORSnet Access Page: 

a. If you're a registered user, type in your DOORS username and, if necessary, a password. 

Note:	 The DOORS username may be different from the name you used to register with 
DOORSnet. Your DOORS Database Manager controls DOORS usernames and 
passwords—if you forget your DOORS username or password, contact your 
DOORS Database Manager. 

b. Click OK. 
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You see a new browser window which shows the DOORSnet Explorer. 

Note:	 The DOORSnet Explorer window may take a while to appear the first time you log in to 
DOORSnet, because data is loaded into your browser cache. This does not occur at any 
subsequent log in. 

4. Navigate to the view you want to look at. 

The DOORSnet Explorer shows the projects, folders, modules and views in the DOORS 
database. It looks and behaves like Windows Explorer. You expand and collapse the database 
hierarchy by clicking the plus and minus signs. 

In the following example, the Sailboat project contains the System Tests module that contains 
the Standard view. 

All projects are shown at the top level of the database hierarchy, even if they are also 
sub-projects of another project. 

Find the view you want to look at, then click its hyperlink. 

Using DOORSnet 



15 

If you click on a module instead of a view, you get a default view of the module which is 
determined by the person who published it, or the last view you looked at in this session. 

5.	 When you've finished click Explore to return to the DOORSnet explorer or click Log out to 
end your DOORSnet session. 

Note:	 Always log out when you've finished, to free up a DOORSnet session for another user. If 
you forget to do this, DOORSnet automatically ends your session after an hour, but 
meanwhile you're using up a session, which may stop someone else from being able to use 
DOORSnet. 
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3
 Navigating 

This section contains the following topics: 

• Scrolling through HTML pages 

• Using the forward and back arrows 

• Browser and server time-out 

• Using link arrows 

Scrolling DOORSnet divides the view you're looking at into HTML pages, and downloads one page at a time 
through HTML to your browser. By default, there are 30 objects on each page. You can control the number of 

pages objects per page. See “Preferences,” on page 21 for details.. 

To navigate between the pages of a view, you click the object ranges on the navigation bar at the 
bottom of your browser screen. 

The module title bar shows how many objects are in the view you're looking at. 
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If you're browsing a large module and the navigation bar can't accommodate all the object ranges, 
you can scroll through them using the navigation arrows. 

Use this arrow To scroll object ranges 

One set of rangesor 

Five sets of ranges 
or 

or 
To the first or last set of ranges 

If you want to download every object in the current view in a single HTML page, use the Get entire 
module option (see “Get entire module,” on page 23). Note that if the module contains lots of 
objects, downloading the entire module may take a long time, and subsequent performance may be 
poor. 

Note:	 To stop downloading data, click Stop at the right-hand side of the DOORSnet tab bar. 
This can be useful if you want to stop downloading an entire module or if there is a 
problem with your network. 

Using the Whenever you click on an object range, it sends a request to the DOORSnet server to download the 
forward and requested information, even if you downloaded it earlier. 

back arrows	 If you want to look at information you downloaded earlier, use the forward and back arrows at the 
right-hand side of the DOORSnet tab bar, next to Refresh and Stop. 

Use this arrow To scroll 

To the previous page 

To the next page 

These arrows don't send requests to the DOORSnet server, so you don't waste time waiting for the 
information to be downloaded again. They work in the same way as the standard forward and back 
buttons in your browser. 
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Note:	 If several people are editing a module at the same time, it's possible that not all the 
information on your screen is fully up-to-date. If you want to be sure you have the most 
up-to-date information, click Refresh. 

Browser and 
server time-out 

Many webservers and browsers time out after five minutes. When a browser times out, it doesn't 
display any of the data you requested. To get around this problem, the DOORSnet server does as 
much as it can before your browser times out. 

When the DOORSnet server is processing a request that takes a long time, it times out after about 
four minutes. It stops processing the request and sends all the data it's got so far. So in your browser, 
you see as much of the data as possible, and you see a message that says that not all the data you 
requested could be sent in the available time. 

If this happens when you're downloading a page, you don't see as many objects as you should. If you 
need to see the other objects, either: 

•	 Try to download the page again (click Refresh, at the right-hand side of the DOORSnet tab 
bar). 

If the DOORS database is not so busy, the DOORSnet server may manage to process all of your 
request and download the whole page. 

•	 Change your user preferences to specify a smaller number of objects per page (see 
“Preferences,” on page 21), then try again. 

Using link 
arrows 

You see an arrow like this  when an object has an in-link from another object. 

You see an arrow like this  when an object has an out-link to another object. 

For example, in this picture, both of the objects have in-links. 

Click on the link arrow to display a list of hyperlinks that take you to the linked objects. 
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For example, if you click the link arrow on the Lifevests object in the following example you see a 
list of three hyperlinks: 

Each hyperlink consists of the path to the module that contains the target object, followed by the 
number part of its object identifier. To go to the page that contains the linked object, click the 
hyperlink. 

In this example, if you click the third hyperlink, /Sailboat/Requirements: 60, you go to the target 
object in the Requirements module. Notice that the page automatically scrolls so that the object is 
visible. The target object is highlighted and there is an exclamation mark to the left of the action 
button. 
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4 Using the DOORSnet tab 

This section describes options on the DOORSnet tab: 

• Explore 

• Preferences 

• Update password 

• Print 

• Get  entire module 

• Save 

• Save and unlock 

• Discard 

• Unlock 

• Log out 

Explore 

If you want to see a different module or view: 

1. Click the DOORSnet tab. 

2.	 Click Explore. 

You navigate to the DOORSnet Explorer. 

3. Find the view you want to look at, then click the hyperlink to see the view. 

Note:	 If you click on a module name instead of a view in the DOORSnet Explorer, you get the 
last view you looked at during the current DOORSnet session. If you haven't looked at 
the module during this session, you get the default view determined by the person who 
published the module. 

Preferences
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To show or change your user preferences: 

1. Click the DOORSnet tab. 

2. Click Preferences. 

You can control the following options: 

Option Description 

Notify updates by 
email 

Show proposals from 
the last n days 

Objects per page in 
browser 

Use Java rich text 
editors 

Personal information 

Controls whether you're automatically notified by e-mail if the status or 
priority of one of your proposals changes. 

Note: If you're an anonymous user, you won't see this option. 

Controls the maximum age of proposals you see by default. 

Controls how many objects you see in your browser when you're 
looking at a view. By default, there are 30 objects per page. For more 
information, see “Scrolling through HTML pages,” on page 17. 

Lets you apply rich text formatting (such as bold and underline) when 
editing. If you want to use plain text when editing, uncheck this box. 

You can type in your e-mail address, postal address, telephone number, 
and any additional information. 
Note that all of the personal information shown on this screen is stored 
with your proposals, and can be seen by other people when they look at 
your proposals. So only include information you want other people to 
see. For example, if you want them to be able to call you, include your 
telephone number, otherwise leave the telephone box empty. 

Note: If you're an anonymous user, you won't see this option. 

Update 
password 

To update your password: 

1. Click the DOORSnet tab. 

2. Click Update password. 

3. Type your current password in the Old password box. 
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4.	 Type your new password in the New password box, then type it again in the Confirm new 
password box. 

5. Click OK. 

Print


To print the current page: 

1. Click the DOORSnet tab. 

2. Click Print.


You see your browser's standard Print dialog box.


Get entire 
module 

Normally DOORSnet downloads a module in manageable pieces. The number of objects it 
downloads is determined by your user preference settings (see “Preferences,” on page 21). 

Downloading an entire module can be useful if you want to print the entire view. But if the module 
contains lots of objects it can take a long time to download, and subsequent performance may be 
poor. 

To download the entire module: 

1. Click the DOORSnet tab. 

2.	 Click Get entire module. 

DOORSnet downloads every object in the current view to your browser. 

If DOORSnet times out during the download 
For information on time-outs, see “Browser and server time-out,” on page 19. 

If the DOORSnet server times out before it manages to get the entire module, you see a More 
option on the module title bar instead of the object ranges on the navigation bar at the bottom of 
your screen: 

1.	 Click More to download more of the module. This downloads the next four-minute's worth of 
data. 

You now have a Previous option on the navigation bar. You can use Previous to move to the 
previous page of data, and More to move to the next page until you are on the last page of 
loaded data. 
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2.	 While on the last page of loaded data, click More to download the next four-minute's worth of 
data. 

3.	 Repeat until the entire module has been downloaded, when the More option is no longer 
available. 

More and Previous are only available for the Get entire module option. 

Save 

When you edit an object, the changes are temporarily stored on your computer. To make the changes 
permanent you have to explicitly save them, which stores them in the DOORS database. 

If you have unsaved changes, the objects you edited have a red colored background and a plus sign 
to the left of the action button: 

There is an asterisk on your module title bar: 

You can either save the changes without unlocking the section, or save them and unlock the section. 

Saving without unlocking is useful if either: 

•	 You're making lots of changes to the section and you want to save the changes you've made so 
far, then carry on editing it. 

•	 You want to look at something on another page and keep your lock on the section to make sure 
that another user can't edit it. For example, if you want to follow a link to another module to 
check something. 

To save your changes without unlocking the section: 

1. Click the DOORSnet tab. 

2. Click Save. 
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Note:	 If you navigate to the DOORSnet Explorer or to another page when you have a locked 
section, you see a message like this: 

If you want to keep the lock, click Cancel. If you want to unlock the section, click OK. 

Save and unlock


You can save your changes and unlock the section in one operation. 

To save your changes and unlock the section: 

1. Click the DOORSnet tab. 

2. Click Save and unlock. 

Discard 

If you edit an object and then decide to change it back to how it was before you edited it, you can 
discard the changes you made. 

To discard your changes: 

1. Click the DOORSnet tab. 

2. Click Discard. 

Note:	 You can only discard changes when you edit an object. You can't undo object create or 
delete operations. 

Unlock 

When you edit an object or insert or delete objects, DOORSnet locks the appropriate section. To let 
other users work on the same data, you should always unlock the section when you have finished 
editing. 
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To unlock the section: 

1. Click the DOORSnet tab. 

2. Click Unlock. 

Log out 

When you've finished using DOORSnet, always log out to free up a DOORSnet session for another 
user. If you forget to do this, DOORSnet automatically ends your session after an hour of inactivity. 

To log out: 

1. Click the DOORSnet tab. 

2. Click Log out. 
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5 Using the Search tab 

This chapter describes options on the Search tab: 

• Filter 

• Find 

• Advanced 

• Defining an advanced search 

Filter 

Note:	 Use a simple filter to search the text attributes in the current view. For information on how 
to use an advanced filter, see “Advanced,” on page 29. 

To use a simple filter: 

1. Click the Search tab. 

2. In the search box, type the text you want to search for. 

Note:	 Simple searches are not case sensitive. If you need to do a case sensitive search, use an 
advanced search (see “Advanced,” on page 29). 

3. Click Filter. 
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4.	 The filter is applied—only objects that contain the information you typed are shown. The screen 
turns blue, and the module title bar changes to show the filter you've applied. 

Find 

Note:	 Use a simple find to search the text attributes in the current view. For information on how 
to use an advanced find, see “Advanced,” on page 29. 

To use a simple find: 

1. Click the Search tab. 

2. In the search box, type the text you want to search for. 

Note:	 Simple searches are not case sensitive. If you need to do a case sensitive search, use an 
advanced search (see “Advanced,” on page 29). 

3. Click Find. 

The view scrolls to show the first object that contains the information you typed. All the objects 
that match the search criteria are highlighted and have an exclamation mark to the left of the 
action button. 
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4.	 You can scroll to the next and previous found objects by clicking the Next and Previous 
buttons on the module title bar. 

Advanced 

Use the advanced search option to do an advanced filter or find. 

Note:	 For information on how to do a simple filter, see “Filter,” on page 27. And for information 
on how to do a simple find, see “Find,” on page 28. 

To do an advanced filter or find: 

1. Click the Search tab. 

2. Click Advanced. 
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You see a screen similar to the following example. 

3. Define the advanced search (see “Defining an advanced search,” on page 32), then click either: 

•	 Filter to filter out objects that don't match the search criteria that is currently highlighted in 
the Current search list box. 

•	 Find to find objects that match the search criteria that is currently highlighted in the 
Current search list box. 

Advanced filter 
When you do an advanced filter: 

• The screen turns blue. 

• Only objects matching the search criteria are shown. 

•	 If you used a saved search list, its name is shown as a hyperlink in the module title bar. Otherwise 
the hyperlink says (not saved). 

Note: Click the hyperlink if you want to modify the advanced search criteria. 
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The results of an advanced filter are shown in the following example. 

Advanced find 
When you do an advanced find: 

• The  screen turns grey. 

•	 Objects matching the search criteria are highlighted and have an exclamation mark to the left of 
the action button. 

•	 If you used a saved search list, its name is shown as a hyperlink in the module title bar. Otherwise 
the hyperlink says (not saved). 

Note: Click the hyperlink if you want to modify the advanced search criteria. 
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The results of an advanced find are shown in the following example. 

Defining an 
advanced search 

The basic building blocks of advanced searches are called search criteria. 

To define search criteria: 

1.	 On the Advanced search screen, select the attribute you want to search on using the drop-down 
list. For example, select Object Text. 

2.	 Use the next drop-down list to select the operator, for example, select contains (case 
insensitive). 

3. In the next box, enter the value you want to search for. For example, type in the word mast. 

4.	 Click the Add button just below the criteria to add it to the Current search list box on the right. 
In this example, it adds Object Text contains (case insensitive) mast to the current search 
list. 
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Defining a complex search 
Underneath the current search list are And, Or and Not buttons that you can use to build up 
complex searches. 

Use If you want to 

And Search for all the objects that match two or more search criteria. 
For example, you want to search for objects that have a priority greater than 3 
and “mast” in their object text. 
Select the criteria you want to and together, then click And. 

Or Search for all the objects that match one or more search criteria. 
For example, you want to search for objects that either have a priority greater 
than 3 or “mast” in their object text, or both. 
Select the criteria you want to or together, then click Or. 

Not Search for all the objects that don't match a particular search criteria. 
For example, you want to search for objects that don't have “mast” in their 
object text. 
Select the criteria, then click Not. 

And, Or, and Not add a new entry to the current search list. 

Although you can have many entries in the current search list, you can only use one of them in an 
advanced search. Select the entry you want to use in your advanced search, then click either Filter or 
Find. 

The selected entry is called the active entry. 

To delete one or more entries from the search list, select the entries then click the Delete button 
underneath the current search list. 

Using saved search lists 
You can save a search list, so that you can reuse it later. This is useful if you often want to use 
particular search patterns. It saves you having to define them every time you want to use them. 

For example, Dave saves two search lists called MeToDo + High and MeToDo + Medium: 

•	 MeToDo + High searches for all the high priority tasks he has to do. Its active entry is ((Who 
is equal to Dave AND ToDo is equal to Yes) AND Priority is equal to High). 

•	 MeToDo + Medium searches for all the medium priority tasks he has to do. Its active entry is 
((Who is equal to Dave AND ToDo is equal to Yes) AND Priority is equal to Medium). 
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Using saved search lists can also simplify the text you see in the search list box, and make it easier for 
you to see what the search does. 

For example, Dave follows these steps to produce the screen shown in this example: 

1. Click Clear to clear the Current search list box. 

2.	 In the Saved search lists box, select MeToDo + High, then click the Add button below it to 
add it to the Current search list box. 

3.	 In the Saved search lists box, select MeToDo + Medium, then click the Add button below it 
to add it to Current search list box. 

4.	 In the Current search list box, select both entries, then click Or. This adds a new entry 
(MeToDo + High OR MeToDo + Medium). 

To search for all of his high or medium priority tasks, Dave selects the (MeToDo + High OR 
MeToDo + Medium) entry in the Current search list box, then clicks either Filter or Find. 
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Note:	 If you save the search list before you click Filter or Find, the blue bar at the top of your 
screen tells you the name of your search list. For example, if Dave saved the search list as 
MeToDo: High + Medium, and then clicked Filter, the blue bar would look like this: 

Click the hyperlink on the blue bar to go to the advanced search screen to find out about the current 
search. 

Note:	 DOORSnet saves search lists on a per module basis. The names of your saved search lists 
must be unique within a module. 

If you click Filter or Find to use a saved search list whose active entry refers to attributes that aren't 
available in the current view, you get an error message. 
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6 Using the Proposals tab 

This section describes options on the Proposals tab:


• Make suggestion


• Show all proposals


• Show my proposals


Make suggestion 

Note:	 The Make suggestion option is always available from the DOORSnet Explorer window 
but it's only available from a module window if the project has been configured for review. 

For information on how to make a change proposal against a particular object, or to propose a new 
object, see “Submitting a change proposal,” on page 49. 

To make a suggestion about the current project: 

1.	 Click the Proposals tab, then click Make suggestion. 

You see a suggestion form. 

2.	 Fill out the form: 

• Type in your suggestion. 
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• Type in the reason why you're making the suggestion. 

Try and give as much information as possible to help the project's review team understand 
your suggestion properly and increase the chances of it being accepted. 

• Use  the Change type drop-down list to select the type of your suggestion. 

• Use  the Priority drop-down list to select the priority of your suggestion. 

Note:	 Be realistic and don't exaggerate the importance of your suggestion. The project's 
review team will probably downgrade the priority if you exaggerate. 

3.	 Click Submit to submit your suggestion. 

You see a message saying that your suggestion has been submitted. 

4. Click OK to acknowledge the message. 

Show all 
proposals 

Note:	 The Show all proposals option is always available from the DOORSnet Explorer window 
but it's only available from a module window if the project has been set up for review. 

To see all the proposals that have been submitted for the current project: 

1. Click the Proposals tab. 

2. Click Show all proposals. 
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By default, you only see proposals submitted within the time-frame specified in your user preferences 
(see “Preferences,” on page 21). Click the icon on the title bar to show all proposals, regardless 
of their age. 

You see several tables: 

•	 First there's a table that contains a summary of all the suggestions for the project. It's divided 
into sections that group together the suggestions made by each user. 

•	 Then there's a table for each module that has any change proposals. It groups change proposals 
by user, and summarizes all the change proposals. 

•	 Finally, there's a table that summarizes all the suggestions and change proposals. It shows the 
total number of suggestions and change proposals in each status category (new, approved, 
rejected, and so on). 

Suggestions 
There is one suggestions table that includes all the suggestions for the whole project. The suggestions 
are grouped by user, so you can see all the suggestions submitted by a particular user. 

Some DOORSnet users are identified by the e-mail address they used to register with DOORSnet; 
y are DOORSnet guest users. Anonymous users are identified by a username determined by thethe 

DOORSnet administrator. 

Column Description 

ID A unique identifier assigned to the suggestion. 

Description The actual suggestion. 
If the suggestion is long, it is truncated. To see the full suggestion, click the 
details icon . 

Status The status of the suggestion. 

Stapled to	 If the suggestion is stapled to another proposal, this is the object identifier of the 
master proposal. 
Click the object identifier hyperlink to go to the entry on the current page for the 
master proposal. 

Details	 Click the details icon  to see full details about the suggestion, such as 
reviewer's comments and information about who submitted it. 

Change proposals 
There is one change proposals table for each module in the project that has change proposals. Within 
each table, the change proposals are grouped by user, so you can see all the change proposals 
submitted by a particular user. 
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Some DOORSnet users are identified by the e-mail address they used to register with DOORSnet; 
they are DOORSnet guest users. Anonymous users are identified by a username determined by the 
DOORSnet administrator. 

Column Description 

ID A unique identifier assigned to the change proposal. 

Description The type of the change proposal and the object it applies to. 

Click the icon to see the object the change proposal applies to. 

Status The status of the change proposal. 

Stapled to	 If the change proposal is stapled to another proposal, this is the object identifier 
of the master proposal. 
Click the object identifier hyperlink to go to the entry on the current page for the 
master proposal. 
If you click the master proposal's details icon, you'll see an icon in the top left 
corner of the new screen that tells you how many proposals are stapled to the 
master. Click this icon to show a summary of all the proposals in the staple set. 
On the new summary screen, click the details icon for any proposal to show full 
details about the proposal. 

Details	 Click the details icon  to see full details about the change proposal, 
including reviewer's comments and information about who submitted it. 

On the details screen there's an icon in the top left if there are other 
change proposals against the same object. Click the icon to show a summary of 

anth ge pre ops ose ch als. 

Show my 

proposals


Note:	 The Show my proposals option is always available from the DOORSnet Explorer window 
but it's only available from a module window if the project has been set up for review. 

To see only the proposals you have submitted for the current project: 

1. Click the Proposals tab.


2. Click Show my proposals.


For information about what you see on the screen, see “Show all proposals,” on page 38.
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7 Using the Sort and Display tabs 

This section contains the following topics:


• Using the Sort tab


• Using the Display tab


Using the Sort 
tab 

Use the Sort tab to either:


• Sort the objects in the current view.


• Cancel the current sort.


To sort the objects in the current view:


1. Click the Sort tab. 

2.	 Use the drop-down list to select the attribute you want to sort on. The drop-down list includes 
all the attributes in the view. 

Note:	 You can't sort on attributes whose values are calculated dynamically, such as Object 
level. 

3. Click Ascending or Descending to choose the order of your sort, and to sort the table. 

Notice that the table you're looking at turns light green, and the module title bar displays a 
message like the one shown below. 

To cancel a sort, click the Sort tab, then click Clear. 
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Using sort arrows 
If you're using table format, you can also use sort arrows to sort your data. Using the sort arrows is 
quicker than using the Sort tab. 

Use the sort arrows on a column heading to sort on the column: 

• Click the up arrow to sort in ascending order. 

• Click the down arrow to sort in descending order. 

For example, to sort all the objects in the current view in order of descending priority, click the down 
arrow on the Priority column. 

Notice that: 

• The color of the arrow you clicked changes from blue to red. 

• The table you're viewing changes color. 

•	 The green bar at the top of your screen displays a message that tells you which attribute the data 
is sorted on and the order of the sort (ascending or descending). 

To cancel the sort, click the arrow again. Its color changes back from red to blue, and the table you're 
viewing goes back to its original color. 

Note:	 There aren't any sort arrows on the main column, which contains two attributes, the Object 
Heading and the Object Text. If you want to sort on the Object Heading or Object Text, 
use the Sort tab. 
Columns that you can't sort on don't have arrows. For example, there aren't any arrows on 
columns that contain values that are calculated dynamically, such as Object level. 

Using the 
Display tab 
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To change the way modules are displayed: 

1. Click the Display tab. 

2.	 Check the Book format box if you want to view information in book format (see “Table and 
book formats,” on page 11). 

3. Check the Show pictures box if you want to control whether pictures are displayed. 

Note:	 DOORSnet goes faster if you don't show pictures. Pictures take time to download to 
your browser. 

4. Click Apply. 

Note: The display options you choose apply to all views. 
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8 Using action buttons


This chapter describes the action buttons you use to perform actions on particular objects: 

• What are action buttons? 

• Editing  an  object 

• Inserting an object 

• Deleting an object 

• Submitting a change proposal 

• Showing change proposals against an object 

What are action 
buttons? 

An action button lets you perform tasks that apply to a specific object, such as editing the object. 
An action button is a square button at the left-hand side of the main column. 

Note:	 If your view doesn't have a main column, the action button is shown in a narrow column 
on the left of the table. 

When you click an object's action button, you see an action window that lists all the actions you can 
apply to the object. An example action window is shown below 

You may see a different set of actions depending on the level of access you have to the module or 
object, or if the module you are using has not been set up for review. For example, you won't see the 
Edit this object action if you don't have sufficient access to edit the object, or if no edit licenses 
were free when you logged in. 

Editing an object To edit an object: 

1. Click the action button for the object you want to edit. 

2. In the action window, click Edit this object. 
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What happens next depends on what user preferences you have set (see “Preferences,” on page 
21). 

a.	 If the Use Java rich text editors box in your user preferences is not ticked, the plain text 
edit window is displayed: 

The following warning message is also displayed if the object to be edited has rich text 
formatting applied to it: 

Note:	 OLE objects are stored as rich text. If you do not want to lose OLE objects when 
editing, always use the rich text editor. 

If you do not want to lose the rich text content, click OK in the warning dialog and click 
Cancel in the plain text edit window, then set your user preferences accordingly (see 
“Preferences,” on page 21) 
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b.	 If the Use Java rich text editors box in your user preferences is ticked, the rich text 
window is displayed: 

The icons on the rich text edit window are described in the following table: 

Use these icons To do this 

Cut, copy and paste the selected text. 

Apply bold, italic, superscript, subscript, underscore or 
strikethrough formatting to the selected text. 
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(Continued) 

Use these icons To do this 

You can insert an object: 

•	 Before or after the current object 

The new object is inserted at the same level in the hierarchy as the current object. 

•	 Below the current object 

The new object is inserted one level below the current object in the hierarchy. 

Note: You can't insert an object in a section that is locked by another user. 

To insert an object: 

1. Click the action button for the object you want to insert before, after or below. 

2.	 In the action window, click the appropriate action. 

The relevant section is locked, the new object is created, and you see the object editor window. 

3. Type in the appropriate attribute values. 

4. Click OK. 

Insert characters from the Symbol and Latin fonts: 
a. Click where you want to insert a symbol. 

b.	 Click the appropriate Insert symbol icon. You see 
the Symbol characters or Latin characters window. 

c. Click the character you want to insert. 

Apply bullet points to a list 

3.	 An arrow is displayed on the action button of each object in the section being edited, indicating 
that there is an edit lock on the section. 

The arrow will remain until the section is unlocked. If the module has not been set up for sharing 
the whole module will be locked. For further information see “Editable sections and locks,” on 
page 9. 

4. Make your edits, then click Apply. 

Note:	 Remember to save your changes (see “Save,” on page 24 or “Save and unlock,” on page 
25). 

Inserting an 
object 

Using DOORSnet 



49 

Deleting an 
object 

Submitting a 
change proposal 

Note:	 You won't have a Submit a change proposal option if your module isn't configured for 
review. 

For information on how to make a suggestion for a project, see “Make suggestion,” on page 37. 

To submit a change proposal for a particular object: 

1. Click the action button on the object against which you want to submit the change proposal. 

2.	 In the action window, click Submit a change proposal. 

What happens next depends on what user preferences you have set (see “Preferences,” on page 
21) 

a.	 If the Use Java rich text editors box in your user preferences is not ticked, the plain text 
change proposal form is displayed: 

Deleting an object also deletes all the objects in the hierarchy below it. 

Note: You can't delete an object in a section that is locked by another user. 

To delete an object: 

1. Click the action button for the object you want to delete. 

2. In the action window, click Delete this object. 

3.	 If you see a message telling you that you are about to delete all the objects in the hierarchy below 
the object, as well as the object itself, click OK. 
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The following warning message is also displayed if the object to be edited has rich text 
formatting applied to it: 

Note:	 OLE objects are stored as rich text. If you do not want to lose OLE objects when 
editing, always use the rich text change proposal form. 

If you do not want to lose the rich text content, click OK in the warning dialog and click 
Cancel in the plain text change proposal form, then set your user preferences accordingly 

“Preferences,” on pa )ge 21(see 

b.	 If the Use Java rich text editors box in your user preferences is ticked, the rich text change 
proposal form is displayed: 

3. Fill out the form: 
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• Type in the reason why you're proposing the change. 

Try and give as much information as possible to help the project's review team understand 
your proposal properly and increase the chances of it being accepted. 

Depending on your preference settings and the capabilities of your browser, you can apply 
either rich text formatting or plain text formatting. 

• Use  the Change type drop-down list to select the type of your proposed change. 

Select this option If you propose to 

Modify this object	 Modify the value of one or more of the current object's 
attributes. 

Delete this object Delete the current object. 

Add new object Add a new object at the same level as the current object. 

Add new object (below) Add a new object one level below the current object. 

• Use  the Priority drop-down list to select the priority of your proposed change. 

Note:	 Be realistic and don't exaggerate the importance of your change proposal. The 
project's review team will probably downgrade the priority if you exaggerate. 

•	 If you're proposing new values for attributes, enter the new values in the Proposed value 
column. See on page 47 for information on the rich text buttons. 

4.	 Click Submit to submit your change proposal. 

You see a message saying that your change proposal has been submitted. 

5. Click OK to acknowledge the message. 

On the view screen, notice that the object you submitted the change proposal against has 
changed color. 

Note: If yo
This icon tells you that the object has a change proposal submitted against it. 

u click Refresh, you'll see a green icon like this on the object's action button. 

Showing change 
proposals 
against an object 

Note:	 You won't have any Show change proposal options if your module isn't configured for 
review. 

To show the change proposals for an object: 

1. Click the action button for the object. 

2. In the action window, click whichever of the following options is listed: 

• Show change proposals against this object 

The object has two or more change proposals, and you see a summary of them. Click the 
details icon on a change proposal to see full details about it. 
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• Show details of change proposal 

The object only has one change proposal, and you see full details about it. 

By default, you only see proposals submitted within the time-frame specified in your user preferences 
(see “Preferences,” on page 21). Click the icon near the top right of the screen to all show 
proposals, regardless of their age. 
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9 Troubleshooting 

This chapter describes how to troubleshoot DOORSnet: 

• If DOORSnet screens misbehave in your browser 

• If you can't see buttons on the advanced search screen 

• If you can't see a proposal any more 

• If you're not being notified by e-mail 

• If your proposal has been stapled to the wrong proposal 

• If nothing happens when you click hyperlink in Stapled to column 

• If the text that you type is small and uses a strange font 

• If the DOORSnet Previous option doesn't work 

Note:	 For the latest information on known problems with DOORSnet and how to work around 
them, visit the support center on our website at http://support.telelogic.com. 

If DOORSnet If DOORSnet screens don't behave properly with your browser, it is probably because your browser 
screens doesn't support DOORSnet. 

misbehave in For the latest information on the browsers that support DOORSnet, the support center on our 

your browser website at http://support.telelogic.com. 

If you can't see If you can't see the buttons on the advanced search screen, you need to refresh your screen display. If 
buttons on the you are using Internet Explorer, press the F5 function key. If you are using Netscape, press Ctrl+R. 

advanced search 
screen 

If you can't see a If you're looking at a proposals summary screen and can't see a proposal that you saw before, it's 
proposal any probably because the proposal was submitted before the time specified in your user preferences. 

more Click the icon near the top right of the screen to all show proposals, regardless of their age. 

If you're not If you're not being notified by e-mail when the status or priority of your proposals changes:

being notified by 1. Click Preferences.

e-mail 2. Make sure the Notify updates by email box is checked.
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3. Check that your e-mail address is correct. If necessary, type in the right e-mail address. 

4.	 Click OK. 

You see a message saying that your new preferences have been saved. 

5. Click OK to acknowledge the message. 

If your proposal If you think one of your proposals has been stapled to the wrong proposal, submit another proposal 
has been stapled explaining why you think that your original proposal was making a different point from the other 

to the wrong proposals in the staple set. 

proposal 

If nothing If nothing happens when you're looking at a proposals summary screen and you click a hyperlink in 
happens when the Stapled to column, it could be because: 

you click • The master proposal is already displayed on your screen. 

hyperlink in Check the ID column to see whether the identifier in the Stapled to column matches that of any 
Stapled to proposal on your screen. 

column • The master proposal is older than the time-frame specified in your user preferences. 

Click the icon near the top right of the screen to all show proposals, regardless of their age. 

If the text that 
you type is small 
and uses a 
strange font 

On some browsers, the text you type in multi-line boxes on change proposal and suggestions forms 
may be very small and use a strange fixed-width font. 

This problem is caused by the way that browsers handle multi-line text input fields. Your browser 
controls which font is used. 

Your browser may have a preferences option that allows you to change this font. For example, if you 
are using Netscape: 

1. Click Edit > Preferences. 

2. On the left of the screen, select Fonts under the Appearance category. 

3.	 On the right of the screen, use the two pull-down lists to select the font and size of the Fixed 
Width Font. 

If the DOORSnet If you're using Internet Explorer, you've been downloading an entire module, and Internet Explorer 
Previous option loses information about which pages you've been looking at, the Previous option doesn't work in 

doesn't work	 DOORSnet. 

In this situation, you can't go back to the previous page. Your browser's Back option is grayed out, 
and DOORSnet's Previous option doesn't work, although it is not grayed out. 
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To return to normal, you must either reload the entire module, or return to the view selection page 
and select the view again. 
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10 Contacting customer support 

This chapter contains the following topics: 

• Before you contact customer support 

• How to contact customer support 

• Contact  Information 

Before you 
contact 
customer 
support 

If your site has a designated on-site support person, please contact that person before you contact 
our customer support team. 

To help our customer support team solve your problem, please have the following information 
available: 

• Your name, title, company name, e-mail address, fax number and telephone number. 

• Your Telelogic DOORS site ID. 

•	 The version and build number of DOORS that you're running. 

To get this information, run DOORS, and click Help > About DOORS. 

•	 The version of DOORSnet that you're running. 

To get this information, run DOORS,and click Tools > DOORSnet > About DOORSnet. 

• The operating system you're running DOORS on, for example, Windows NT 4.0 Service Pack 6. 

• The operating system you’re running DOORSnet on, if different. 

• What operating system your DOORS database is running on, if different. 

• The name and version of your web browser. 

•	 If you are reporting a new problem, please have a clear statement of the problem, including the 
exact text of any error messages produced by DOORSnet, your operating system, or any other 
tools that were running when the problem occurred. 

•	 If you are calling about a problem you reported earlier, you need the original tracking number the 
customer support team assigned to your problem. 

How to contact Visit the support center on our web site at http://support.telelogic.com. 
customer Alternatively, you can e-mail or telephone us. 
support	 Contact information for users in the Americas, Europe, Scandinavia, Asia and Pacific is shown 

below. 
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Contact Information 

Americas 

e-mail doorssupport.us@telelogic.com 

telephone +1 800 577 8449 

service hours 9 am – 8 pm EST 

Europe/Scandinavia 

e-mail doorssupport.eu@telelogic.com 

telephone	 +44 (131) 622 3636 (Europe) 
+44 (131) 622 3640 (Germany) 

service hours 8:30 am – 5 pm GMT 

Australia and New Zealand 

e-mail support.australia@telelogic.com 

telephone	 +61 (2) 9904 6315 (International) 
1300 659 671 (Australia) 

service hours 9 am – 5 pm AEST 

China 

e-mail support.china@telelogic.com 

telephone +86 (10) 8518 5130 

service hours 9 am – 5:30 pm GMT+8 

India 

e-mail support.india@telelogic.com 

telephone +91 (80) 5112 4443 

service hours 9 am – 5:30 pm GMT+5.5 

Japan 

e-mail support.japan@telelogic.com 

telephone +81 (3) 6402 1650 
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Japan 

service hours 9:30 am – 6 pm GMT+9 

Korea 

e-mail support.korea@telelogic.com 

telephone +82 (2) 561 8512 

service hours 9 am – 6 pm GMT+9 

Taiwan 

e-mail ttcjason@ms42.hinet.net 

telephone +886 (2) 2213 5279 

service hours 9 am – 6 pm GMT+8 

Other Asian countries 

e-mail support.asia@telelogic.com 

telephone +91 (80) 5112 4443 

service hours 9 am – 5:30 pm GMT+5.5 

For up-to-date contact information, visit the following URL: 
http://www.telelogic.com/support/contact/ 
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